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Overview  

According to Murphy's Law of Data Loss, " The probabilities of a hard-disk crash increase with 
the number of days since the drive was last backed up." 

No hard disk drive is ever completely safe from crashing, and losing all the important data on it.  
A disk drive can be damaged due to a number of causes such as virus attack, voltage glitches, 
software malfunction, hard disk format, accidental file/directory deletion, human error or even 
sabotage.  Such events cause corruption or damage to the disk drive, and make the data 
completely inaccessible to the user. 

In most cases, retrieval of such lost data is practically impossible, and this can mean grave losses 
to the user.  The user has to rebuild his files from previous backups, and if improper or no backup 
has been taken, even construct the information again from scratch. In today's age of information 
technology, data represents time as well as money, and such a loss of data could be a 
catastrophic event. 

This is precisely why a tool like Stellar Phoenix comes in handy to recover your lost data.  Stellar 
Phoenix is a unique product, which allows you to recover precious data from inaccessible hard 
drives, which have been damaged due to a variety of reasons like  
 
-Accidental format 
-Partition loss 
-Virus related corruption 
-File/directory deletion  
 
 
 
How Stellar Phoenix works? 
 
Stellar Phoenix is NON-DESTRUCTIVE and READ-ONLY Software. It will recover your data and 
copy it to another destination a removable drive, another working partition, another hard drive, a 
floppy diskette or a network volume. 
 
Stellar Phoenix is very easy to use. The software's fully automated wizard will walk you through 
the simple steps: 
 
·  Evaluate - Phoenix identifies the device and locates all partition(s) on the inaccessible drive 

and presents them in a list. 
 
·  Analysis  - It examines the remains of FAT file structure (Boot Sector, FAT copies, Root 

directory) and the data area of the inaccessible drive and works the best path out to recover 
your files and directories. 

 
·  Recover - All recoverable files and directories are presented in a tree structure.  The files and 

directories are color coded to indicate their respective status. You can select your data files 
and directories and move the data to a safe location. � �

 
NOTE: Be aware of strange noises coming from your hard drive, as this might be an indication of 
a more serious problem.  Continuing to operate your system may damage your hard drive beyond 
repair or cause irretrievable data loss. If you suspect hardware problems see  
 
Technical Support contact information. 
 
Check to confirm that you have the System Requirements to run Stellar Phoenix here.  



 
Click on Data Recovery Basics to learn a little more about the process.  
 
Click Here to get started.�
 
 



 

System Requirements 
 
 
· Pentium-class processor 
 
· 64 MB RAM (128 MB recommended) 
 
· Windows 9x/ME, Windows NT 3.51and above, or Windows 2000 or Windows XP 
 
· 5 MB of free space  
 
To learn more about the recovery process: Data Recovery Basics 
 
For instructions in recovering data: Selecting the partition to recover 
 
Back to Overview 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Data Recovery Basics 

 
Stellar Phoenix helps data recovery from damaged media in a very simplistic manner, which 
requires no extra effort on the user's part.  Any disk drive is classified into two parts, the data area 
and the system critical information area.  The data area is where the data is stored, while the 
system area stores information about how and where the data has been stored.  In most cases of 
data loss, it is the system area of the drive that gets damaged and not the actual data area itself.  
The system area contains information about how to access data from the drive, and since this is 
damaged, the complete disk drive becomes useless.  This means that the data is still present on 
the drive, and in such a case a tool such as Stellar Phoenix can help you to retrieve it, even if the 
system area has been damaged. 

While Stellar Phoenix can recover files that have been accidentally removed from your computer, 
it is much more than a file undelete program. Even if your computer has severe file system 
corruption, Stellar Phoenix can locate, recover and restore the data. Removal of files from your 
computer does not result in physical removal. The data can be brought back. Some control 
information is still available that can help us in salvaging the data pieces. Using the state of the 
art proprietary technology Stellar Phoenix finds those footprints and then displays the list of all the 
files, folders and even lost partitions. Even disks with very little control information Phoenix can 
still recover files and directories. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Supported File Systems 
 
Stellar Phoenix for FAT can recover data from these operating systems: 
 
File System 
 
Operating System File Systems Used 
 
Windows 95, 98             FAT16, FAT32 
Windows XP       FAT16, FAT32 
Windows 2000  FAT16, FAT32 
 
Windows NT 3.x or 4.x FAT16 
 
Stellar Phoenix for FAT can also retrieve data from SCSI hard drives 
 
See Also: 
 
Back to Overview  
 
Click here to see the installation procedure 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Installing Stellar Phoenix FAT 

 
Run setup.exe from the Stellar Phoenix Software Diskette (or, if you downloaded Stellar Phoenix, 
run the downloaded setup file from Windows Explorer) to begin the installation process.   
 
NOTE:  You should not install Stellar Phoenix to the partition you are trying to recover (doing so 
may result in overwriting recoverable files).   
 
Back to Overview 
 
See Also: 
 
How to Recover Data 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Uninstalling Stellar Phoenix FAT 

 
To remove Stellar Phoenix: 
 
1 Make sure the program is closed. 
 
2 From Windows, select Start-->Programs-->Stellar Phoenix for FAT-->Uninstall. 
 
3 Confirm your decision by clicking Yes, remove Stellar Phoenix. 
 
Back to Overview 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Selecting the Partition to Recover 
 
 

 
 
On executing Stellar Phoenix you will see the above screen. Phoenix scans and displays all the 
physical drives it finds. Select the physical disk from which you wish to recover your data and 
click on the OK button. 
 

 
 
Phoenix presents with two options at this moment (see above screen image). You can either 
search for logical drives in the selected disk or use drive information that is stored in the partition 
table. 
 
Use partition table information option to recover deleted or lost folders & files. You may also use 
this option if the drive is accidentally formatted. However, do not use this option if partitions have 
been recreated. 
 
If the partition table is damaged and no information about logical drives is available, you should 
select "Search for logical drives". 
 
If you select the option to search for partitions, Stellar Phoenix searches for partitions or logical 
drives in the hard disk and updates you the result. 
 
 
 
 



 
 
The logical drives found in the search will be displayed next.  If had earlier selected the "Use 
Partition Table Information", Phoenix reads the logical drive information and displays them as 
shown in above Figure. 
 
Select the FAT partition (drive) from where data has to be recovered. Phoenix analyses the 
selected logical drive. The search process encompasses three phases where it searches: 
 
-Normal Entries 
-Deleted Entries 
-Lost Entries 
 

 
 
After scanning all possible file and folder entries, Phoenix gathers up all the information obtained 
so far, and creates a tree structure. The file and folder entries are now displayed in a manner that 
is easy to view and navigate. 
 
 
 
 
 
 



Tree Structure 

 

 
 
After the recovery scan of the selected drive is complete; Stellar Phoenix will display the contents 
of the crashed drive in a window that looks like a file manager. On the left panel you can see the 
folders and subfolders under the root. The right panel displays the files and sub folders under the 
currently selected folder. A check box is also provided with every file and folder for selection on 
both the panels. A status bar at the bottom displays the number of file(s) and folder(s) in the 
selected folder 
 
You can arrange the display of icons on the right panel using view option from the menu bar 
based upon their Type, File Size, Creation Date and Name. In similar fashion you can view the 
icons in different modes by right clicking your mouse and selecting any of these options or 
selecting view option from menu bar. 
 
-Large Icons 
-Small Icons 
-List 
-Details 
 
 
Named Folder(s)  
All the folder names that are retrieved are displayed with their original attributes. These are 

displayed with following icon.   
 
 
 



Normal files are displayed with their details. Following icon is used to display a normal file.  

  
 
 
Lost Folder  
The lost or missing folders are put together under the LOST FOLDER icon. These folders had 
corrupt system information and their original cannot be retrieved. The folders are assigned names 
"Lost Folder 0001" in an increasing numeric order.  
 

The lost folders are displayed with following icon.   
 
 
Deleted Folder 

Deleted folders are displayed with this icon.     
 
 

Deleted files are displayed with this icon.     
 
 
 
 
All the above folder types can be recovered using any of the recovery options.  
 
Now you're ready to copy your recovered files. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



File Search Method 
 

When the software displays the tree structure, you can use Find option in Tools menu to search 
for file(s) and folder(s) in the tree. 

 

 
 

A dialog box appears, where you can enter a search string based on the file or folder name. You 
will see three search criteria. 

 

Match Case 

On selecting this option Phoenix search becomes case sensitive. 

 

Deleted Entries 

On selecting this option phoenix would search the string in deleted folder(s) 

 

Existing Entries  

On selecting this option phoenix will search for the string the existing entries, the file(s) folder(s) 
that were still accessible after any data loss. 

 

Repeat search can be performed by selecting option Find Next in Tools menu bar option or by 
pressing F3 key. 

 

 

 

 

 

 

 

 

 

 

 

 



File Filter 

 

Before transferring the data to the destination path, one can include or exclude certain files on the 
basis of their extensions using file filter options. 

 

Suppose for instance you want to recover the files having extension of .DOC, .PPT so you would 
add these extensions in file filter option and press include. After recovery only the files having 
these extensions will be transferred. 

 

Similarly if exclude option is selected then files which are not having these extensions would be 
left out and won't be transferred. 

 

 
 

You can add as many as extensions you want to include or exclude. 
 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 



Recovering Files to a Safe Location 

 
This is the last but most important process in recovering your lost data. After you have found the 
files and folders that need to be recovered you need to transfer them to another media. You can 
recover data on to another logical drive of the same disk or another working hard disk or a 
network drive. 
 
Select the destination folder in the target drive that would store the recovered data. Stellar 
Phoenix will copy the desired files and folders to the selected destination folder. Once you click 
on the OK button, a dialog box would pop up and give you a continuous progress on the 
percentage of files copied. 
 
Phoenix gives three options to recover your data. 
 

·  Recovering Selected Files 
·  Recovering Deleted Files 
·  Recovering All Files in Drive 

 
 
Recovering Selected Files 
Use this option to perform selective file or folder recovery. Select the files and/or folder by clicking 
on the check box displayed next to them. When you have completed files/folders selection 
choose "Recover Selected Files" option in File Menu. Alternatively you can also click on the 
Recover Selected Files icon on the Toolbar to start this process. 
 
A dialog box pops up prompting you to select the destination path. Select the destination folder; 
you are ready to begin recovering data. Click Ok to begin. 
 
 
Recovering Deleted Files 
Use this option to recover ALL deleted file(s) or folder(s) in the selected drive. Select "Recover 
Deleted Files" option.  A dialog box pops up listing you the drives and folders. Select a 
destination folder; you're ready to begin moving data. Afterwards click Ok to begin. 
 
 
Recovering All Files in Drive 
Use the option "Recover All" to recover ALL (including deleted, lost and numbered files and 
folders) the files and folders from the inaccessible drive.  A dialog box pops up listing you the 
drives and folders. Select a destination folder; you're ready to begin moving data. Afterwards click 
Ok to begin. 
 

WARNING 

You should never try to save recovered files/folders on the same logical 
disk where they are located. This may produce unpredictable results and 
loss of data.  
 
Note:  
Stellar Phoenix recovers files from FAT partitions, but it can write recovered data to FAT or NTFS 
local disks or network drives. Stellar Phoenix successfully recovers files from FAT partitions.  
 
 
 
 



 

How Can I Recover Data from Formatted Drives? 

 

Recovery of DATA from Formatted Drive. 

 

To recover data from a formatted hard drive, follow these steps: 

 

- Click the Select Physical Disk button on the Icon Toolbar.  

 

- A dialog box appears listing the physical disk available 

 

- Select the physical disk that contains the formatted logical drive 

 

- Another dialog box pops up, select Use Partition Table option 

 

- Select the formatted logical drive from the list 

 

- Phoenix analyses the drive data structures and file system attributes and displays the directory 
tree. 

 

- Some data structures are critically damaged after a drive format. It is HIGHLY recommended 
that you should use advanced search option in cases of formatted drive recovery. 

 

- After Advance Search process is complete you will find all the files and directories in the tree 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Recovery of Data from Corrupt or Missing Partition 

 

To recover data from a Drive containing corrupt or missing partition, follow these steps: 

 

- Click the Select Physical Disk button on the Icon Toolbar.  

 

- A dialog box appears listing the physical disk available. 

 

- Select the physical disk that contains the corrupt or missing logical drive. 

 

- Another dialog box pops up, select Search for Logical Drives option. 

 

- Phoenix would scan the hard disk for all the lost partitions and would present the list of found 
partitions. 

 

- Select the corrupt or missing logical drive from the list. 

 

- Phoenix analyses the drive data structures and file system attributes and displays the directory 
tree. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



How I can Recover Deleted File(s) or Folder(s)? 

 

To recover data from a Drive containing deleted file(s) or folder(s), follow these steps: 

 

- Click the Select Physical Disk button on the Icon Toolbar.  

 

- A dialog box appears listing the physical disk available. 

 

- Select the physical disk that contains the deleted file(s) or folder(s). 

 

- Another dialog box pops up, select Use Partition Table Information option. 

 

- Select the logical drive containing deleted file(s) or folder(s) from the list 

 

- Phoenix would scan the hard disk for all the deleted file(s) or folder(s) and would present the list 
of found file(s) or folder(s) 

- Select the file(s) or folder(s) from the list for recovery. 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



How I can Recover Missing File(s) or Folder(s)? 

 

To recover data from a Drive containing missing file(s) or folder(s), follow these steps: 

 

- Click the Select Physical Disk button on the Icon Toolbar.  

 

- A dialog box appears listing the physical disk available. 

 

- Select the physical disk that contains the missing file(s) or folder(s). 

 

- Another dialog box pops up, select Use Partition Table Information option. 

 

- Select the logical drive containing missing file(s) or folder(s) from the list 

 

- Phoenix would scan the hard disk for all the missing file(s) or folder(s)  

  And would present the list of found file(s) or folder(s). 

 

- Select the file(s) or folder(s) from the list for recovery. 

 

- Some data structures are critically damaged when an incident of missing folders occurs. It is 
HIGHLY recommended that you should use advance search  option in cases of missing file(s) or 
folder(s). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Advanced Search 

 

This feature is helpful in the cases when the file(s) and folder(s) are not visible in standard 
search. To recover these files an intensive search process is required. 

 

To execute Advanced Search go to Tools menu and select Advanced Search option. This 
rigorous search process looks for the still missing file(s) and folder(s) in the selected drive. 

 

  
 

 

Note:  

 

This process is time intensive and can take few hours in some instances. 

 

If the file(s) and folder(s) are still not visible after this search process, the files or its control 
information is overwritten and the data cannot be restored. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Linking Mode 

 

The software gives you an option to choose three linking modes 

 

 

FAT1, FAT2, Contiguous 

 

When to select linking modes? 

 

Stellar Phoenix processes the drive if there is no FAT table present. This may be useful if the 
drive has been reformatted and thus a new FAT table is created and the old one is deleted. In this 
case, it is reasonable to recover files from the previous drive without processing the new and 
irrelevant FAT table. All files will be recovered as continuous byte chains beginning from their 
start cluster by selecting contiguous mode. Un-fragmented files will be recovered successfully. If 
it is FAT1 or FAT2, Stellar Phoenix uses the first or second FAT table copy, respectively. 

 

The default-linking mode is FAT1, to select linking mode go to Tools menu and select options in 
change linking mode as shown in fig: 

 

  

 
 
 
 
 
 
 
 
 



 

Technical Support  
We provide product support (except on Sundays and Holidays), to all our customers through  

 
·  Email 
·  Telephone 
·  Online Forum 
·       Our Office 
 

Support Timings  

 2100 Hrs to 1000 Hrs (US & Canada West Coast) 
 0000 Hrs to 0900 Hrs (US & Canada East Coast) 
 0400 Hrs to 1300 Hrs (GMT) 
 1330 Hrs to 2300 Hrs (Australia, New Zealand, East Asia)  
 0930 Hrs to 1830 Hrs (South Asia - India) 

Email  

Please send your product support queries at following id. 
support@stellarinfo.com 
 
All support emails are usually replied within one business day. 

Telephone 

You may call us at any of the numbers below 
Delhi 
(91)-11-641 8809, 641 8810, 644 8808, 644 8810, 629 2262 
Mumbai 
(91)-22-821 5946, 821 5947, 696 4559 
Bangalore 
(91)-80-532 7865, 532 7866 
Online Forum 

Technical support and data recovery questions can be submitted electronically by visiting the 
technical support section of our website. Please visit the link below: 
http://www.stellarinfo.com/data-recovery-software-support.htm 
 
Contact Us 

Stellar Information Systems Ltd. (An ISO 9002 Company) 

Delhi: 
304, Deepali Building 92, Nehru Place 
New Delhi-19, India 
Mumbai: 
 
108, B-Building, Gokul Arcade, Subhash Road 
Near Garware Chowk, Andheri (East) 
Mumbai-57. India 
 
Bangalore: 
S-712, South Block, Manipal Center,  
Dickenson Road, Bangalore-42. India 
 
 



Key Terms 
 
 
 

File System 
 
File System is a component of operating system, which manages data on any storage media 
 
 
FAT 
 

FAT (File Allocation Table) is a type of file system which is supported by all Microsoft Operating 
System it has variants like FAT16 and FAT32. 

FAT32 is not supported in Windows NT 3.5 / 4.0 operating system. 

 
NTFS 

NTFS (New Technology File System) is a file system, which is supported by Windows NT. 

 
 
NTFS5 
NTFS5 is the new version for NTFS file system, which is supported by Windows 2000 and 
Windows XP operating system. 
 
 
Partition 

A formatted section of your hard drive. Drives formatted by DOS or Windows 9x / ME have at 
least one partition, labeled C:  

 

The first partition is called primary partition. Large drives can be formatted to have multiple 
partitions by creating extended partitions and then dissecting them into logical partitions.  

 

Each partition will then behave as if it were a separate physical drive, with its own letter (D, E, F, 
etc.). Unlike DOS in Windows NT we can have more then one primary partitions i.e. up to 4 
primary partitions. 

 

Cluster 

The basic unit of storage on a logical drive. A cluster is a group of sectors. One cluster is 
allocated to a single file only. Cluster sizes can vary from 512 bytes to 256k bytes, depending on 
the particular file system and the partition size.  

 
Sector 

The smallest storage units on a disk. A sector can hold 512 bytes of information. 

 
 



 

 

Cross-linked files 

If your system crashes while you're saving a file, the File System may report that two files share 
at least one common cluster on the logical drive. These files are cross-linked files. These files are 
not accessible under NTFS file systems 

 

NT does support hard links and they will not be described as cross-links.  A hard link is simply 
another name (possibly in another folder) that contains exactly the same contents. 

 

File Allocation Table 

In DOS and Windows, data is stored in distinct clusters on the drive. DOS creates a File 
Allocation Table (FAT) to track where each file is stored.  

 


